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Hyperion Overview 

Overview 
 

Hyperion is a centralized, Excel and Web-based planning, budgeting and forecasting solution 
that integrates financial and operational fiscal processes and improves business predictability. 
Support Units enters budget data through web forms using a web browser. Current year budget 
and two years of actual data are provided to facilitate the budgeting process. Support Units can 
also choose to open these same forms in Smart View which is integrated into Excel to input and 
submit the budget through Excel.   

 

Support Unit Budget Cycle 

 
There are important milestones throughout the UF Budgeting process you should be aware of 
depending on whether you are budgeting for a Support Unit (SU), Responsibility Center (RC), 
Colleges, State Funded Center (SFC) or hybrid. 
 
Starting in November of every year, Support Units make their budget requests for the upcoming 
fiscal year to the UF Budget Office.  The requests are reviewed and approved by Senior Vice 
Presidents and the President. 
 
Click here for SU Budget Request Whole Cycle Document 

Starting in May/June, all budget personnel will receive their final budgets and can then manage 
and distribute the monies as appropriate across their Budget Preparation and All Funds Budget. 
 
Click here for All Funds Budget Whole Cycle Document 

 

http://training.hr.ufl.edu/instructionguides/hyperion/hyperion_whole_cycle-su_budget_request_cycle.pdf
http://training.hr.ufl.edu/instructionguides/hyperion/hyperion_whole_cycle-all_funds_budget.pdf
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Logging In 
  

The Hyperion Support Unit budget submission application is incorporated to myUFL portal. After 
logging into myUFL, navigate through Nav Bar > Main Menu > Budgeting > UF Hyperion 
Budgeting. 

 

Hyperion opens with the HomePage displayed by default. 
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NOTE: 
You may choose to display either the HomePage or the UBO_PSPB Application as the opening 
page by changing this setting in Hyperion User Preferences. 

 
 

Setting Hyperion User Preferences 
Let’s look at how to setup user preferences before we begin using the application to prep and 
request UF budgets. Setting user preferences allows you to define the default content that will 
display when you login to Hyperion (mandatory). It also allows you to define formatting, page 
options and additional options (optional). 

 

Changing Default Opening Page (This is an optional setting change) 
1. From the Hyperion application window, go to File > Preferences. 

 

 

2. From the General preference option, click the Home Page drop down menu and choose 
Application from the list. 

 

 

3. Select the Application drop down menu and select UBO_PSPB from the Planning list. 
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4. Click OK.  

 
 
Changing Hyperion Display Settings  
 
To change the display settings, you must first open the UBO_PSPB application.  The display 
options must be established prior to using the Hyperion application for requesting UF budgets.  

 

1. Open UBO_PSPB from the Quick Links section of the Home Page.  (If you’ve already 
changed the preferences to display UBO_PSPB immediately upon login, you would skip 
this step).  
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NOTE: 
If you have previously opened the UBO_PSPB application, you can open it again from the 
Recently Opened section on the HomePage, if displayed. 

 

2. Choose File > Preferences from the Menu bar. 
 

 
NOTE:  You can also click the Preferences section  under the My Task List panel. 
 

3. Choose File > Preferences from Menu bar and click the Planning option or click the 
Preferences option at the bottom of the left panel. 
 

 
 

4. Move to the Display Options. Click on Display Options.  
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5. Select your desired options. 
 

You are welcome to customize your desired Display Options settings as you see fit.  Some 
suggested default settings include: 

 

Number Formatting 

 Thousands Separator – choose Comma 

 Decimal Separator – choose Dot 

 Negative Sign – choose Prefixed Minus 

 Negative Color – choose Black 

 

Page Options 

 Indentation of Members on Page – choose Indent Level 0 members only 

 This option dictates the look and feel of data categories on web forms. 

 

Other Options 

          Using the default settings is highly recommended  

 

 

Changing Hyperion User Variable Settings  

You are typically required to submit two budgets as part of your overall Budget Request 
Submission process annually.  The two budgets are referred to as: 

 

 Working Flat – the budget you had last year 

 Working Optimal – the optimal budget you’d like to have to run your unit. 
 

Under budget constraints, you may be asked to submit a Working Cut budget. 

 Working Cut – the flat budget cut by a certain percentage.  The UBO will inform you of a 
percentage each year and if this submission is required. 

 

As part of the Hyperion preference setup, you will indicate three User Variable settings. These 
settings will need to be changed when you shift your budgeting from Working Flat to Working 
Optimal or vice versa.  
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 Scenario: SU_Budget (Stays the same for all versions) 

 Version: Working Flat and Working Optimal (Will change depending on version working 
on) 

 Year: FYXX (this is the fiscal year you are budgeting for and it stays the same for all 
versions) 

 
It is recommended you initially set “Working Flat” as your default budget version.  After you 
finish all the personnel changes and operating expenses for Working Flat, you will need to 
change this preference to Working Optimal to update the budget on this version. 
 
Although you can choose to return to this Preferences window to make the changes to the 
additional budget versions, there is a more quick and direct method of changing budget 
versions in Budget Preparation that will be covered later in this handbook. 
 

  
 

NOTE:  The above screen displays when one choosing File > Preferences from Menu bar.  If you choose 
the Preferences option under My Task List, the window would look as below: 
 

 
 

6. Click OK or Save depending on which way you accessed Preferences. 

 

You are now ready to navigate through the application.  
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Workspace 

Hyperion Navigation 
 

 

  

Toolbar Icons   
 

 Save Save the input data 

 Refresh Refresh  the form 

 Print Print the current screen 

 Adjust 
Adjust the selected cell value by a percentage or by 
a value  

 Grid Spread Spread value  

 Mass Allocate Run a mass allocation  

Menu Bar Tool Bar 
Content Area 

Open 
Application 

View Pane 
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 Comment Add or edit comment to the selected cell. 

 

Lock/Unlock 
Cells Lock or unlock cells when spreading data.  

 

Supporting 
Detail Add or edit supporting details to selected cell. 

 

Add/Edit 
Document 

Add or edit attached documents for the selected 
cell. 

 Instructions Show the instruction details for the open data form. 

 

Open in Smart 
View 

Open data from in Smart View. (This button does not 

work and will not be used.) 

 

 

Some tools can be accessed by right-clicking on the desired area of the form and displaying the 
shortcut menu. 
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Hyperion Processes 
 
As a Support Unit, there are two specific and individual processes you will complete using 
Hyperion to successfully request your budget each fiscal year.  Those processes include 
multiple procedural steps and are titled: 
 

 Budget Preparation 

 Support Unit Budget Request Submission 

 

My Task List 

 
You will use the My Task List to access all needed forms and functions for Budget Preparation 
and Support Unit Budget Requests. 
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Budget Preparation Overview 

NOTE:  Choose Budget Preparation from the My Task List Pane. 
 

The annual Budget Request Submission process includes completing relevant procedures 
within both Budget Preparation and Support Unit Budget Request Submission before submitting 
to the University Budget Office (UBO). 
 
In this section, we will cover the available procedures in Budget  Preparation in the order the 
University Budget Office recommends as best practice.  Required Budget Preparation 
procedures are recommended to be completed first, prior to completing Support Unit Budget 
Request Submission procedures. 
 
There are a total of 16 budget prep procedures displayed in the image below from which you 
may choose to successfully prepare your budget. 
 

  
 

There is no specific order you need to follow to finish your budget request.  We recommend you 
run the Budget Line & Benefits report first.  Review the employee and positions currently in 
Hyperion.  Make all necessary changes on the personnel side.  Once the salary and fringe 
expenditures are up to date, review your OPS and operating expenditures. 
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Running Hyperion Reports 

Please keep in mind that the reports will not be updated until after the push has occurred in 
Hyperion.  The push runs every two hours starting at 7am and ending at 7pm Monday thru 
Friday.  On Saturday and Sunday the push will run every two hours starting at 11am and ending 
at 7pm. 
 
We have found that the push typically takes about ½ hr to run.  We recommend you run the 
reports an hour after the push times (7:30 am, 9:30 am, et al.) to see any changes that were 
made before the push occurred.   
 

Navigation to all reports 

 
1. Log into myUFL and navigate through Main Menu > Enterprise Reporting > Access 

Reporting. 
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2. From the Public Folders tab, select Financial Information > Budget > UF Budgeting. 
Once inside you will choose the report you want to run from the list provided. 
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Budgeted Lines + Benefits Report 
 
The Budgeted Lines + Benefits Report gives you a list of where all employees are currently 
budgeted and their benefits within Hyperion. This report can be run by the following additional 
search criteria Employee, Entity (Home Department), Comp Entity (Earnings Department), and 
Filled or Vacant.  Please note Comp Fund (Earnings Fund), Comp Program (Earnings Fund), 
Comp Dept Flex (Earnings Dept Flex) are available search criteria, however for the SU Budget 
Request cycle no data will pull if these values are selected since we do not use these values at 
this time. 

 
1. Login to my.ufl.edu. Click on Main Menu > Enterprise Reporting > Access Reporting. 

 

 
 

2. Go to Public Folders > Financial Information > Budget >UF Budgeting. Select 
Budgeted Lines + Benefits 
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3. Choose your required search criteria. In this example, we are running the budge line for 
Support Unit Flat Budget for FY17. The parameters are selected as below.  

 
 
 

4. Choose your additional search criteria.  In this example, we will use HR_6201 data.   

 
NOTE: Please note that there are two types of Entities.   
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One is the employee’s home department which is referred to as “Entity” on the 
search criteria page.  The home department starts with “HR_”.   
 
The other one is the employee’s earnings department which is referred to as 
“Comp Entity” on the search criteria page.  The earnings department starts with 
“D_”.   
 
If you search by home department, the report will return all the 
positions/employees who are administrated in that department.  If you search by 
the earnings department, the report will return all the positions/employees who 
are paid by that department. 

 
 

5. Scroll to the bottom of form or top of the form. Click Finish and wait for the report to run. 
6. Review your report. 

 

 
 

NOTE:  At this time each person has at least two rows of data.  The one row of data is the 
salary expense data line and the one row is the benefit data line.   
 

Additional Earnings + Benefits 
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The Additional Earnings + Benefits Report gives you a list of any employee where that 
employee has had additional earnings and their benefits input into Hyperion.   For example, 
some units budget up life insurance and other misc. benefits as additional earnings.  This report 
can be run by the following additional search criteria Employee, Entity (Home Department), 
Comp Entity (Earnings Department), and Filled or Vacant.  Please note Comp Fund (Earnings 
Fund), Comp Program (Earnings Fund), Comp Dept Flex (Earnings Dept Flex) are available 
search criteria, however for the SU Budget Request cycle no data will pull if these values are 
selected since we do not use these values at this time. 
 

1. Select Additional Earnings + Benefits 
 

 
 

2. Choose your required search criteria. 
 

 
3. Choose your additional search criteria.  In this example, we will use HR_6201 data.  

After entering scroll to bottom of form or top of the form. 
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4. Click Finish and wait for the report to run. 

 

 
 

 

 
5. Review your report. 
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Benefit Selection 
 
The Benefit Selection Report gives you a list of all employees benefit selections that have been 
input into Hyperion. This report can be run by the following additional search criteria Employee, 
Entity (Home Department), Comp Entity (Earnings Department), and Filled or Vacant.  Please 
note Comp Fund (Earnings Fund), Comp Program (Earnings Fund), Comp Dept Flex (Earnings 
Dept Flex) are available search criteria, however for the SU Budget Request cycle no data will 
pull if these values are selected since we do not use these values at this time. 

 
1. Select Benefit Selection 

 
 

2. Choose your required search criteria. 

 
 

3. Choose your additional search criteria.  In this example, we will use HR_6201 data.  
After entering scroll to bottom of form or top of the form. 
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4. Click Finish and wait for the report to run. 
 

 
5. Review your report. 
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Support Unit Budget Request 
 
The Support Unit Budget Request Report gives you the support unit budget requested by Fiscal 
Year, Version, Scenario, Entity, Account, Cost Pool, and Commitment Source in total and 
spread monthly. 

 
1. Select Support Unit Budget Request 

 

 
2. Choose your required search criteria. 

 
 

3. Choose your additional search criteria.  In this example, we will use D_62 data.  After 
entering scroll to bottom of form or top of the form. 
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4. Click Finish and wait for the report to run. 

 
5. Review your report. 
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Budget Preparation Processes 

Manage Position and Employee Data Forms 

 
Maintain position data 
This form should only be used to make changes to positions.  Updating employee distributions 
and data is performed within a different form. 

Maintain filled positions 
This form should only be used to make changes to existing and to-be-hired employees.  This is 
where you would make any changes to distributions, salary, benefits, etc. 

Maintain employees by position 
Maintain employees by position was originally designed to display positions and employees 
together in one form, but due to the level of complexity and resulting confusion, the UBO does 
not recommend using this form.  

 
Fill to-be-hired vacancies 
This form was originally designed to replace to-be-hired employees with named employees if 
they are hired.  Because we don't add new hired employees to Hyperion after the snap shot, 
you will never need to use the Fill to-be-hired vacancies functionality.  In this training, we still 
show you the steps on how to fill a to-be-hired vacancy.  However, keep in mind you will not 
need to do that in Hyperion.  This form is currently used by the departments to review all the to-

be-hired employees. 

 

 

Update Current Employees’ Distributions & Data 
 
This procedure is used to make changes to particular parameters of an employee’s distribution, 
such as changing an employee’s Entity. 
 

1. From the Maintain filled positions form, choose your desired Entity from the Entity 
drop down field. 



 

Support Unit Budget Request 25 January 3, 2018 

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 

 

3. Click the Distributions tab. 
NOTE:  You may have to scroll to the right to view the Distributions tab. 

 

In this example, we will be changing the employee’s Entity and assigning the appropriate Cost 
Pool Segment and Commitment Source Segment.   

4. Select the Entity Segment drop down field and click on the down pointing arrow. 

5. Enter the desired Entity number into the Search field (e.g., "6340").  Or choose it from 
the list. 

NOTE: When searching, you do not have to type D_  in the Entity field.  You can just 
type in 6201 and the list should automatically move to the correct options.  You may also 
choose to scroll to the appropriate list item. 

6. Click the new desired Entity. 
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7. Select the Cost Pool Segment field and click the down pointing arrow. 

8. Click the desired Cost Pool Segment option (e.g., General Admin). 

 

9. Select the Commitment Source Segment field and click the down point arrow. 

10. Click the desired Commitment Source option (e.g., Support Unit Funding).  
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11. Make any changes to the Allocation Start and End Dates if needed. 

12. If any changes are needed to the Percentage Allocation field, make those here.   
NOTE:  You must have a number in the percentage cell and all lines must be 100% in 
total.  Do not leave any 0% distribution lines. If you do not need that line please delete 
the allocation not being used.  

 
13. Click the Save button, then click OK. 

Notice that any red or yellow fields no longer appear once you save your changes. 

 
 
 

Add an Additional Distribution for the same Employee 

 
It’s not uncommon for an employee to hold multiple positions or have multiple distribution 
sources at UF.  This procedure covers how to add an additional distribution for the same 
employee. 
 

1. From the Maintain filled positions form, choose your desired Entity from the Entity 
drop down field, if needed. 
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2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 

 

3. Click the Distributions tab. 
NOTE:  You  may have to scroll to the right to view the Distributions tab. 

 

4. Right-click the 1st Allocation label. 

5. Click the Add Distribution Information link. 
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6. Enter the Effective Start or End Date if it’s different. 

 
NOTE:  It’s very rare to budget a person in the middle of a fiscal year. 

7. Click the Add button on the bottom, right of the screen. 

8. Click OK to the pop up window. 

 

9. Once the additional allocation appears, select an entity from the Entity drop down list 
and select the appropriate department from the list. 

NOTE:  You may need to search for the desired entity.  

NOTE:  Red cells indicate required data that is currently missing. 

 

10. Click the Cost Pool Segment, Commitment Source Segment field, and Allocation 
Start and End Dates and enter the appropriate data.   
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11. Make changes in the Percentage Allocation fields of both allocation lines. 

NOTE: Keep in mind, the combination of all distribution lines must equal 100% 
allocation.  Please do not leave any 0% distribution lines.  If it is not needed delete the 
distribution allocation. 

 

12. Click the Save button. 
NOTE:  Remember any red or yellow cells should clear after saving. 
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Delete a Distribution  
 

1. From the Maintain filled positions form, choose your desired entity from the Entity 
drop down field, if needed.  

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 

 
 

3. Click the Distributions tab. 
NOTE:  You may have to scroll to the right to view the Distributions tab. 

4. Right-click the Allocation label you wish to delete.  
 

5. Select Delete Distribution Information. 
 

6. Click OK to the pop up window. 
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6. Click in the Percentage Allocation field of the remaining allocation. 

7. Enter "100". 
NOTE:  Remember, the lines must add up to 100. 

 

8. Click the Save button. 
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Calculate and Allocate Compensation Budgets per Edit 
 
After each edit you make, you may choose to calculate and allocate.  These procedures will 
process all needed calculations and allocate the updated data to the Support Unit Budgets 
forms within Hyperion. 
 
These procedures can take a long time depending on your area and number of employees.  As 
such the University Budget Office recommends you run these procedures from the Budget Prep 
panel once all edits/updates are done. 
 
If you choose to calculate and allocate after each edit, it’s very important that you note where 
you are before running these procedures as they are very sensitive to location to run accurately.   
 
For example, if you are on the main Maintain position data or Maintain filled positions forms, you 
must right-click on the exact position row you just edited for the calculate and allocate 
procedures to run successfully.  Otherwise, the edited data may not calculate and allocate 
correctly. 
 
If you are in Edit Employee Details, you can right click on any input cell on any tab (except for 
the General tab) to run the calculate and allocate procedures for this position. 
 

 
1. Right click anywhere in the main portion of the edited position. 

 

 
 
2. Click Calculate Compensation Expense. 

 
  



 

Support Unit Budget Request 34 January 3, 2018 

 

NOTE:  You will see an animated blue circle within the Launch Business Rules window while 
the process is running.  See image below. 

 
 

3. Confirm the calculation procedure was successful by noting the message that appears in 
a pop up window.  Click OK. 

 

 
4. After the Launch Business Rules window closes, right click within the same cell on the 

form again. 
 

5. Choose Allocate Compensation Budget to GL Accounts. 
 

 
NOTE:  The Launch Business Rules window will display again until the procedure completes. 
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6. Confirm the procedures have completed successfully by noting the message that 
appears in the pop up window. 

 

 
 
NOTE:  Sometimes the Launch Business Rules window gets stuck.  If you notice the calculation 
or allocation has been running for long time, you can check to make sure the rule has finished 
running by clicking Tools>Job Console from the Menu bar.   
 
If the last column says “Completed”, the procedure has run successfully.  If not completed, click 
Tools > Job Console again to refresh the screen until the job reads Completed. 
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Assigning an Existing Employee 
 
If you know you will be hiring a new current full time UF employee from another department 
before the snap shot was taken you will need to add them into Hyperion so that you can account 
for their salaries.  This process must be started by using the Maintain position data form and 
finished using the Maintain filled positions form. 
 
NOTE:  The snap shot is the status of the data in PeopleSoft on a particular date that is then 
loaded into Hyperion as the base data. 
 

1. From the Maintain position data form, right click the line of the position for which you 
want to assign an existing UF employee.  Make sure the position status is Vacant. 
NOTE:  If the position is listed as Not Budgeted, complete the following steps to assing 
FTE to the position first. 

a. Right click on position and choose Edit Position Details 

b. Click the FTE tab 

c. Right click on assignment label and choose Update FTE 

d. Enter FTE value and the Start and End Dates 
NOTE:  Leave the End Date blank to make this an ongoing change. 

e. Click Add, then OK. 

 

2. Click the Assign Employee option and then click the Assign Existing Employee.  

 

3. Click in the Select Employee field, delete any default text and enter the UFID of the 
appropriate employee.  
NOTE:  the UFID must start with UFID_. 
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4. Enter the correct FTE, Effective Date, Union Code and Full/Part Time status, if 
different from position defaults.  

5. Click the Assign button at bottom right of window.  Click OK. 

6. To confirm the change, click the Maintain filled positions form and verify the assigned 
employee data appears associated with the proper position.  

 

 
 

7. Right click on name of newly assigned existing employee and choose Edit Employee 
Detail to make any needed distribution and salary changes.   

 
8. Click Save button. 

NOTE:  Remember to run the calculations for changes to become active. 
 
 
 

Assigning a To-Be-Hired Employee   
 
You would assign a To-Be-Hired employee for those positions not yet budgeted, but will be in 
the future or for new employees hired after the snap shot was taken.  To include the budget 
information for the future employee in your budget preparation procedure, you would assign a 
To-Be-Hired employee as a place holder. 
 
 

1. From the Maintain position data form, locate the position for which you wish to assign a 
To-Be-Hired employee. Make sure the position status is Vacant. 
NOTE:  If the position is listed as Not Budgeted, complete the following steps to assign 
FTE to the position first. 

a. Right click on position and choose Edit Position Details 

b. Click the FTE tab 

c. Right click on assignment label and choose Update FTE 
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d. Enter FTE value and the Start and End Dates 
NOTE:  Leave the End Date blank to make this an ongoing change. 

e. Click Add, then OK. 

2. Right click on the vacant position and choose Edit Position Details. 

3. Click the FTE tab.  
 

4. Right-click anywhere on the assignment label. 

5. Choose Update FTE.  

 

6. Input the FTE for this position.  

7. Remove the Effective End Date.  
If you do not remove the end date it adds an unnecessary FTE line for the next available 
date sequence. 

 

8. Click Add, then click OK. 

9. Confirm the assignment appears under the FTE tab. 
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10. Right click anywhere on the form and click Return to Previous Form and notice your 
position should now read Vacant in the Occupancy Status field.  

11.  

12. Right-click the Position number.  
 

12. Click the Assign Employee on the pop-up menu.  

14. Click the Assign To-Be-Hired Employee option.  
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15. Enter the name of the new employee or a placeholder name or description if unknown.  
NOTE: If you know the UFID and want to input it best practice is to input it as 
UFID_XXXXXXXX  otherwise if you input a number only the system will treat it as a 
dollar figure and add a decimal and cents.  

16. Be sure to indicate the correct Full/Part Time status, Union Code, FTE and Effective 
Date, if different from default.  

 

17. Click the Assign button, then click OK. 

18. Note the Occupancy Status of the position is now "Filled."  
 

 
 
 

19. Click on the Maintain filled positions form and find the To-Be-Hired employee just 
assigned. 

 
20. Right-click on the To-Be-Hired employee and choose Edit Employee Details. 
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21. If you changed the default FTE value in step 16 above, choose the FTE tab to ensure 
you have a valid FTE. 

 
22. Choose the Salary tab and ensure you have a valid salary.  If not, input the new salary 

dollar amount. If changes are made, be sure to save. 
 
23. Choose the Benefits Elections tab and ensure you have valid benefits and save. 
 
24. Choose the Distribution tab and input your distribution information and save.  
 
25. Run both the Calculate and Allocate procedures.   
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Employee Status Change 
 
Common status changes are inactive (due to maternity leave, military leave, retirement part way 
through the fiscal year, etc.)  

 
1. From Maintain filled positions form, right-click the relevant employee for which you are 

changing status.  
 

2. Click the Edit Employee Details.  
 

3. Click the Status Change tab.  
 

4. Right-click the blue assignment label of the assignment you wish to change.  

5. Click the Change Status option.  

 

6. Double-click the Select Status drop down field arrow. 
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7. Click the appropriate status (e.g., Maternity, Inactive, On Sabbatical, etc.).  

 

8. Enter the desired information into the Enter Effective Start Date field (e.g., "12/1/14") 
and Enter Effective End Date as appropriate.  

 

9. Click the Change button, then click OK. 

10. Confirm the additional allocation displays with the appropriate Action. 

  

13. Run the Calculate Compensation Expense and Allocate Compensation Budget to GL 
Accounts.  

NOTE: The Calculate and Allocate process may take a few minutes.  

14. Go to General tab and change the appropriate Assignment End Date. 
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15. Click the Save button, then the OK button. 

16. Right click and click the Return to Previous Data Form option.  
 

 

 

Removing an Assignment 

 
1. From the Maintain filled positions form. 

 
2. Right-click the Name of the individual of which you want to delete. 

 
3. Select Delete Employee Assignment.  
 

 
 

4. Once the process has run you will now notice that the employee is no longer listed in the 
Maintain filled positions form. 

 
 
 

Change FTE 
 

Occasionally the Full Time Equivalency (FTE) of a position or person may change.  Examples 
are full-time positions changing to part-time, part-time positions changing to full time or a 
different part-time status.   
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NOTE:  Prior to completing the Change FTE procedure, please check the Default Weekly Hours 
cell to ensure you are adjusting your FTE correctly.  Default Weekly Hours listed as 40 is 
equivalent to 1.0 FTE.  Be aware that some employees have default weekly hours of 20 (not 
40).  The equivalent FTE for this would still be 1.0, not 0.5.  If you inputted 0.5, that would be 
equivalent to 10 hours, not 20. 

 
FTE may be changed either per position or per employee. 
 
To change the position FTE only 
When you budget salary to a vacant position directly and need to update the position to part-
time, you change the FTE only. 
 

1. From the Maintain position data, right click on the position to which you wish to change 
the FTE.   
 

2. Click the Edit Position Details option. 
 

3. Click the FTE tab. 
 

4. Right-click in the Proposed FTE field. 
 

5. Select Update FTE from the pop-up menu.  
 

  
 

 

In this example, we are changing the position from a 1.0 FTE to a 0.5 FTE. 
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6. Replace the 1 in the Enter FTE field with .5. 
 
7. Select the default data in the Effective End Date field. 

 
8. Press [Delete] key on keyboard to remove the Effective End Date to make this an 

ongoing change. 
 

 
 

9. Click the Add button, then click OK. 
 

10. Confirm the assignment updates correctly. 
 

  
 

To change the FTE for an employee. 
When you budget salary to an employee and need to change the employee to part-time, you 
change the FTE for the employee. 
 

1. From the Maintain filled positions, right click on the name of the individual you wish to 
change the FTE.   

 
2. Click the Edit Employee Details option. 

 
3. Click the FTE tab. 

 
4. Right-click in the Proposed FTE field. 

 

5. Select Update FTE from the pop-up menu.  
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In this example, we are changing the position from a 1.0 FTE to a 0.5 FTE. 
 
6. Replace the 1 in the Enter FTE field with .5. 

 
7. Select the default data in the Effective End Date field. 

 
8. Press [Delete] key on keyboard to remove the Effective End Date to make this an 

ongoing change. 
 

 
 

9. Click the Add button, then click OK. 
 

10. Confirm the assignment updates correctly. 
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Promote a Position and employee including Fringe Benefit changes 
 
This procedure would be used when you are hiring a new employee and do not have an 
appropriate vacant line for that position.  You can use any one of the vacant lines you have and 
change the Job title and, if needed, change the Salary Admin plan which adjusts the Fringes.    

 
1. From the Maintain position data form, select the vacant position for which a promotion 

will be provided. 
 

2. Click on the job name cell once. 
  

3. Click the job drop down arrow. 
 

4. Use the Search field to search for a position name or job number and select or choose 
the position from the list if it already appears. 
 

 
 

NOTE:  The cell may flash to yellow to indicate a recent edit has not yet been saved. 
 

5. Click the Save button. 
 

6. If no additional changes are needed to this position, skip to step 21.   
 

In this example, we need to change the benefits from a USPS Non-Exempt rate to a Faculty 
Exempt rate. 
 
 
Change the Salary Admin Plan 
 

7. Right-click on the newly changed position.  
 

8. Choose Edit Position Details. 
 

9. Click the Salary tab.  Notice the Salary Admin Plan still says TU2N which is a TEAMS 
USPS Non-Exempt salary plan. 
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10. Click the Fringes tab and notice the fringes are TEAMS USPS fringe rates. 

  
 

11. Go back to the Salary tab and right click on any of the cells in the Position Details 
section. 

 
12.  Click Delete Salary Information, then click OK. 
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13. Right-click on any cell in the Position Details section and choose Add Salary 
Information to add a new salary admin plan. 
 

 
 

14. Click the Salary Grade Select Members icons to search for and locate the appropriate 
salary grade for this position. 

  
In this example, we will choose FA12, which is a Faculty 12 month Salary Admin Plan. 

 
15. Expand the Salary Grades and Faculty categories, and then click FA12. 

 
16. Once FA12 is chosen click the right arrow to send it over to the Element area on the 

right hand side and then click OK.  
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17. From the Add Salary Information window, adjust your Effective Start Date if needed.  In 
this example, we will leave it at 7/1/2016. 
 

18. Click the Add button, then click OK. 
 
After adding the new salary, you must run the Calculate Compensation Expense for the new 
Fringe Benefit to be reflected. 
 

19. Right-click on any cell in the Position Details section and choose Calculate 
Compensation Expense.  And then run the Allocate Compensation Budget to Gl 
Accounts calculation. 

 
 

20. Go to the Fringes tab and notice the fringes are now Faculty fringes. 

 
 
 

Promote an Individual 
 
Use this procedure if you have employees who have changed to new job titles after the dataload 
(or after Hyperion is open) 
 

21. Click Maintain filled positions from the Budget Prep panel. 
 

22. Click on the job name on the position and select the drop down arrow. 



 

Support Unit Budget Request 52 January 3, 2018 

 
23. Use the Search field to search for a position name or job number and select or choose 

the position from the list if it already appears. 

 
 

NOTE:  The cell may flash to yellow to indicate a recent edit has not yet been saved. 
 

24. Click the Save button, then click OK. 
 

25. If the Salary Admin Plan is changed, you need to update the Salary Admin Plan on the 
position.   

 
You will update the Salary and Fringe benefit, if needed. 
 

26. Right-click on the name of the employee holding newly changed position.  
 

27. Choose Edit Employee Details. 
 

28. Repeat steps 9 – 20 above as needed. 
NOTE:  Make sure you do that on the employees. 
 

29. Click the Save button. 
 

30. Run Calculate compensation budgets and Allocate compensation to general ledger 
accounts as needed. 
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Add Overtime Pay or Additional Earnings  
 
This procedure allows you to apply overtime or additional earnings to an employee’s salary 
information.  Examples of when overtime or additional earnings would be if you have a person 
that will need to work overtime, SPI, or is a Sr. Level manager and has additional earnings they 
receive. 

 
1. From Maintain filled positions, right click on the name of the person to whom you 

want to add overtime.  
 

2. Click the Edit Employee Details option. 
 

3. Click the Additional Earnings tab. 
 
4. Right-click on the blue section that states “Right-click and add Additional Earnings 

Elements portion of the screen.” 
 

5. Click the Add Additional Earnings option. 

 
 

6. Click the Enter Additional Earning Select Members drop down icon.  

7. Click the Display Properties icon. 

 

8. Click the Alias menu.  



 

Support Unit Budget Request 54 January 3, 2018 

 
 

9. Select OTS Overtime. 
 
NOTE: In this example we are selecting an overtime payment.  You would choose the 
correct additional earnings for our purpose. 

 
10. Click the right arrow to move the item to the right side. 

 

11. Click the OK button. 
 
12. If you want to make this effective as of July 1, 2016, click inside the Effective Start Date 

field. For example, change the date to "7-1-2016". 

 
 

13. Click the Add button, then click OK. 
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14. Click in the Override Option Value field and enter the Amount of the additional 
earnings. For example, enter "500.00". 

 
15. Click the Option End Date field and enter the date this option amount will end. For 

example, enter "7-30-17". 
 

 
 

16. Click the Value Type Input field and a drop down list will appear. Select Amount – July 
which will budget the additional pay amount all in July. 

 
 

17. Click the Save button, then click OK. 
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Add a Vacant Position  
 
If you want to hold a specific dollar amount, but do not plan to hire someone in the near future 
for a specific position you can add a truly vacant line to hold dollar amounts.   

 
1. From the Maintain position data form, find a Not Budgeted or Vacant position. 

 
2. Right-click on the position and choose Edit Position Details. 

 
3. Click the FTE tab and verify the correct FTE is listed. 

 
NOTE: If you do not have a FTE or an inaccurate FTE is currently listed you will need to input 
the correct FTE by completing the following steps: 

a. Right-click anywhere on the assignment line. 
 

b. Choose Update FTE. 

 
c. Enter the appropriate FTE. 

 
d. Click the Add button, then click OK. 

 
NOTE:  If you permanently wanted to change the FTE of this position, you would delete the 
Effective End Date.  Otherwise, the updated FTE will return to the previous value after that end 
date passes. 
 

4. Click the Salary Tab. 
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5. Input a Salary amount to hold in the Override Option Value cell.  Please keep in mind 
that the fringes will automatically calculate so if you have an exact amount you need to 
hold adjust the number you input for fringe benefits. 

 
 

6. Click the Save button, then click OK, 
 

7. Go to the Distribution tab and input your distribution information and save.   
 

8. Run both the Calculate and Allocate procedures.   
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Calculate and Allocate Compensation per Entity  
 

In Hyperion you have the option of calculating and allocating after each transaction or all at 

one at the end of all of your transactions. 

 

Complete these tasks to run the calculation and allocations after all of your transactions for 

the day.   

 

BEST PRACTICE 

Because of the amount of time it takes for the system to complete the running of these 

options, the Budget Office recommends running this at the end of all your transactions, 

rather than after each transaction.  

 

For large units, please run these rules at the four digit department level instead of the 

whole unit.  If these rules are run at the whole unit level, the calculations may cause the 

system to freeze. 

 

1. Navigate to: My Task List > Budget Preparation > Calculations > Calculate 

compensation budgets. 

2. Click the Launch button. 

 

3. To change the entity, make sure the Version is Working Flat (or Working 

Optimal) and the Scenario is SU_Budget.   

4. Select the appropriate Entity. 
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5. Click your Department to select it.  

6. Click the right arrow to move it to the right side of the screen. 

7. Click the OK button. 

 

8. Click the Launch button. 

The system will create a popup let you 

know it was successfully run.  

  

9. Once you see the rule was run successfully, click the Allocate compensation to 

general ledger accounts option. 

10. Click the Launch button. 
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Before going into details on how to select the calculation criteria, let’s define some concepts. 

 Existing Employees are all of the pre-loaded employees. Existing Employees have a valid 

8-digit UFID. 

 Existing Positions are all of the pre-loaded positions. Any position that starts with 

“P_,” “P_A,” “SA_,” or “SB_” is an existing position. 

 To-Be Hired Employees start with “To_Be_Hired” followed by a digit.  

An example is: “To Be Hired 1.” 

 New Positions are all added to Hyperion by the Budget Office per requests from a 

unit. They start with “New Position.” An example is: “New Position 100.” 

Here are the three major instances when you may run the allocate compensation rule.  

 

Each of these calculations correspond with different parameters, which are shown below. 

Review the list of employees/positions in your department. In most cases, you will have 

existing employees on existing positions. When you run the allocate compensation 

calculations for these instances, make sure you use the following parameters: 

Instance 1: Existing employees on existing positions  

 

If you have existing employees on existing positions, you need to set these 

parameters:    Make sure you select EMP_XXXX for Employee criteria and 

POS_XXXX for Position criteria. You can also type those values directly into the 

boxes. The Scenario should always be “SU_Budget” and the Version should 

always be “Working Flat” (or Working Optimal) when you work in the SU 

Budget Request cycle. 
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Instance 2: To-be-Hired employees on existing positions  

 

If you have To-be-Hired employees on existing positions, you need to set these 

parameters: Select New Employees (which represents all the To-be-Hired) for 

Employee criteria, and POS_XXXX for Position criteria. You can also type those 

values directly into the boxes. The Scenario should always be “SU_Budget” and 

the Version should always be “Working Flat” (or Working Optimal) when you 

work in the SU Budget Request cycle. 

 Instance 3: To-Be-Hired employees on new positions  

 

If you have To-be-Hired employees on new positions, you need to set these 

parameters:      Select New Employees (which represents all the To-be-Hired) for 

Employee criteria, and Total New Positions for Position criteria. You can also 

type those values directly into the boxes. The Scenario should always be 

“SU_Budget” and the Version should always be “Working Flat” (or Working 

Optimal) when you work in the SU Budget Request cycle.  

The following steps show you how to make selections for Instance 1. You can follow these 

steps to make selections for instances 2 and 3 as well. 

11.  To change employee selection, click the Search button next to the Select Employee 

box.  

12.  Navigate along the branches to select employee branch for your organization.  

13. Click the right arrow to move it into the right side of the window. 
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14. Click the OK button. 

 

Next, you will select Department as the Entity you want.  

15. Click the Search button next to the Select Entity box. 

 

16. Click the arrow button next to your Department. 

17. Select the Department. 

18. Click the right arrow to put it in the right side of the window.  

19. Click the OK button. 



 

Support Unit Budget Request 63 January 3, 2018 

 

 

To change the position selection, click the Search button next to the Select Position 

box.  

 

20. Navigate the branches to select the positions for your organization. 

21. Click the right arrow to move it to the right side of the screen.  

22. Click the OK button. 



 

Support Unit Budget Request 64 January 3, 2018 

 

23. Confirm Scenario and Version fields display SU_Budget and “Working Flat” or 

“Working Optimal”. 

24. Click the Launch button. 

 
 

Repeat these steps to make selections for Instances 2 and 3 if needed. 

 

NOTE: Besides searching to change your selection values, you can type in all the values 

(such EMP_6330, POS_6330 and HR_6330) directly to the search boxes. 

 

NOTE: If you are at the All Fundsd Budget cycle, please make sure to select “Budget” for 

Scenario and either “Working” for Version. 

 

Remember the BEST PRACTICE 

Because of the amount of time it takes for the system to complete the running of these 

options, the Budget Office recommends running this at the end of all your transactions, 

rather than after each transaction. 
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Review Allocation Results 
To confirm the data has been processed successfully, you'll review a report to show you what 
was processed.  
 

1. Click the expand arrow next to Review entity compensation budgets to view the 
reports available.  
 

2. Click the Review Allocation Results option.  

 

3. View the results to make sure the Allocation process was run.  

 
In this example, you can see that position P_00005478 is displaying an error.  
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Correct Allocation Errors 
Whenever you see red cells in the Review Allocation Results report, that means you have an 
error somewhere with this person/position. 
 
Common errors are: 

 Allocate compensation to general ledger accounts procedure was not run 

 FTE not assigned 

 No distribution assigned 

 Distribution does not equal 100% 
 

1. From the Review Allocations Results report, right click on employee name. 
 

2. Choose Edit Employee Details. 
 

 
3. Check the FTE and Distribution tabs to check if above issues are found. 

 
4. If nothing appears within the FTE and Distributions tabs, calculate and allocate again. 

 
5. Confirm the error has been fixed. 

 
NOTE:  Position number P_00005478 no longer displays the red cell. 
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Copy Working Flat to Working Cut and Working Optimal 
 
As mentioned earlier, you are typically required to submit two separate budgets to the University 
Budget Office each year.  Those budgets are: 
 

 Working Flat 

 Working Optimal 
 
NOTE: Occasionally, an additional budgets may be required.  For example, depending on state 
budget expectations, Working Cut may be required.  You will receive notice from the UBO each 
year on which budgets are required. 
 
If you followed the UBO recommendations, you set up Working Flat as your Current Stage 
budget in Hyperion Preferences and have been working on the Working Flat version to this 
point.  Now you will copy the Working Flat data to the Working Optimal version. 
 
After copying the data over to the other budget version, you can then make the needed edits to 
that budget version as necessary. 
 
 

Copy Working Flat to Working Optimal 
 

1. Click Tools > Copy Version from menu bar. 
 

  
 

2. Choose SU_Budget from Scenario drop down field. 
 

 
 

3. Choose Working Flat from Copy From drop down field. 
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4. Choose Working Cut from Copy To Drop down field. 

 

 
 

5. Click Go button.  
 

 
6. Scroll down and choose your appropriate Budget Prep Entities (always starts with HR_ 

and D_) from the Available Entities list.  Be sure to choose both or the financial data will 
not be copied over. 
 

7. Click the right-pointing Select arrow. 
 

8. Confirm Entity appears in the Selected Entities list.  
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9. If you have annotations, comments, or supporting details you wish to display in this 
version, select the appropriate checkbox.  Otherwise leave blank. 
 

10. Click Copy Data button. 
 

 

 
 

11. Click OK. 
 

  
 
 

12. Confirm the budget version was copied successfully by noticing the confirmation 
message popup window. 
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Selecting Working Optimal for Editing 

 
1. Select appropriate form from Budget Preparation in the My Task List. 

 

 
 

2. Click Current Stage link at top of the form.  
 

 
NOTE:  When you log out of Hyperion, the budget version you have displayed in the Current 
Stage will remain open when you log back in.  Be sure to confirm the correct budget version 
displays in the Current Stage tab at the top of the form prior to making edits. 
 

3. Within the Member Selection window, select Working Optimal from the Version list on 
left side. 
 

4. Click right-pointing Select arrow. 
 

5. Confirm Working Optimal appears in the Version list on right side. 
 

6. Click OK. 
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7. Confirm Current Stage icon displays Working Cut. 
 

 
 

8. Make any desired adjustments as needed for your “optimal” budget. 
a. Reference Working Flat processes above as needed. 

 
NOTE:  Follow the same procedures to copy Working Flat to Working Cut if a Working 
Cut version is required. 
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Support Unit Budget Request  

 

 

 
 

Forms for Support Unit Budget Request  
 
Accessing Forms 
 

1. Expand the Support Unit Budget folder in My Task List.  

2. You should see three forms. 

 SU Budget Worksheet  

 SU Budget Worksheet-Level 0 Accounts Only  

 SU HCP Push Validation 
 

 



 

Support Unit Budget Request 73 January 3, 2018 

 

SU HCP Push Validation 

 
This forms allows you to verify that “the push” has successfully completed and will display the 
salary dollars entered via Budget Prep.  You should verify this information prior to using the 
other two forms. 
 

1. Select SU HCP Push Validation form. 
 

2. Choose your Entity from the Entity dropdown field. 
NOTE:  You may need to search for the appropriate Entity. 

    

3. Choose your Cost Pool from the Cost Pool drop down field. 

 

4. Choose your Commitment Source from the Commitment Source drop down field. 
 

5. Choose the appropriate budget version from the Version drop down field. 

 

6. Click the Go button. 

 

 

Verify the displayed data is what you expected to see pushed from Budget Prep.  If the data is 
unexpected or in error, return to Budget Prep and make any needed corrections. 
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SU Budget Worksheet 
 
Salary data and fringe will automatically be populated from the Budget Prep push.  

 

This form displays account categories and accounts that expand and roll up along with totals at 
the bottom of the columns. Please note either this form or the SU Budget Worksheet- Level 0 
Accounts only form can be used to input salary/fringe budget.  Both forms do the same thing 
they just have a different view. 

 

This form provides two years of actual expenditures and current year final approved budget 
related to your support unit(s).  The actual data includes your support unit expenditure only.  It 
doesn’t include other expenditures such as auxiliary, endowment, etc.  The final approved 
current year budget data is based on the preparation of your budget in Budget Preparation 
(salary portion) and Budget Request Submission (all other expenditures).   

 

NOTE: It is not required to budget at the 8 digit DeptID level or GL account level. It is your unit’s 
decision what level to budget. However, all data must be input at Level 0 members. 

 

If you plan to budget at a higher level, you also need to select one 8 digit DeptID. For example 
Enrollment Management, if you plan to budget at Office of Admission, Office of Registrar’s 
Office and VP of Enrollment Management areas, you can select DeptID 03020000 for Office of 
Admission, DeptID 03030000 for Office of Registrar and 03010000 for VP of Enrollment 
Management. You don’t have to go down to 03020100 or 03020300 deptID level. 

 

Similarly, if you plan to budget at GL account level, select the GL accounts you need to budget 
to and input your value. If plan to budget at higher level, for example, if you want to budget at 
Contractual Services level, pick one GL account under Contractual Services and input your 
value. You can either pick the GL account where you spend most of the Contractual Services or 
pick the GL account “71000 - Contractual Services”. 

 

1. Select your Department from the Entity drop down field (if needed). 

 

2. Select the Cost Pool for your department from the Cost Pool drop down field (if 
needed). 
 

3. Select the Commitment Source from the Commitment Source drop down field (if 
needed). 
 

4. Click the Go button.  
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To input request dollars in for Working Flat and Working Optimal 
 

1. Go to SU Budget Worksheet form. Select the department, cost pool and commitment 
source to budget. Click on the arrow to refresh the page. 
 

 
 

2. Find the GL account to budget. Type in the value amount. And click Save button. 
 

 
 

 
You can also input the value by copy from one cell to another cell. Following steps show 
you how to copy from a cell to another cell. 
 

3. Find the GL account to copy from. Righ click and choose Edit >Copy data (or Cntrl+C). 
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4. A window will pop up with below message. Click Allow access.  
 

 
 

5. Right click on the cell you want to copy to. Choose Edit >Paste data (or Cntrl+V). 
 

 
 

6. Click Save button. 
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SU Budget Worksheet-Level 0 Accounts Only 
 
Salary data and fringe will be automatically be populated from the Budget Prep push.  

 

This form only displays accounts and the accounts don’t expand (roll up).  You will also not see 
totals at bottom of columns. Please note either the SU Budget Worksheet form or this form can 
be used to input budget.  Both forms do the same thing they just have a different view. 

 

Please follow the procedures for SU Budget Worksheet.  

 

Populating Accounts 
 
The populating accounts procedure allows you to add accounts that were not previously used 
but will be needed and used in the future. 

 

1. Right click anywhere in the SU Budget Worksheet form.  
 

2. Select Populate SU Account. 
 

 
 

 
 

From the Runtime Prompts window, indicate the account you wish to add. 

NOTE: Do NOT change any of the other fields in this window. 

 
3. Click the Members Selector button. 
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4. Drill-down and locate the account you wish to add within the left Member Name column. 
Note: When adding OPS Salary accounts please choose the second choice in the list as 
the first choice in the list is the pre-fringe benefit pool account and this account is no 
longer active.  You will not be able to input data into this account cell once added. 
 

In this example, we are going to add an additional Travel account. 

 

5. Click the Total SU Accounts Expand icon. 
 

6. Click the SU_Total Expense Expand icon. 
 

7. Click the SU_Other Operating Expeneses Expand icon. 
 

8. Scroll down, if needed. 
 

9. Click the SU_Travel and Training Expand icon. 

10. Click the 772000 object. 

 

11. Once you have located the desired account, you will move it to the right side Member 
Name Column. 



 

Support Unit Budget Request 79 January 3, 2018 

 
12. Only the accounts listed on the right side will appear in your worksheet. 

 
13. Click the Right-pointing Select arrow. 

 
14. Confirm the correct account appears on the right side. 

 
15. Click the OK button. 

 
 

 
 

16. Click the Launch button. 
 

  
17. After launching the rule, you will receive a confirmation message. 

 
18. Click the OK button.  

 

19. Scroll down to verify the new account has appeared in your worksheet. 
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20. Notice the new account now appears in the Travel and Training section. 

 

 
 

NOTE:  

You can also type in the GL accounts directly into the Select Account(s) to add: field if 
you know which account(s) to add.   

You can add multiple accounts at once by separating each account with a comma. 

 
NOTE: When adding OPS Salary accounts please choose the second choice in the list 
as the first choice in the list is the pre-fringe benefit pool account and this account is no 
longer active.  You will not be able to input data into this account cell once added. 

 

 
21. Click within the Foreign Travel cell of the appropriate budget column. 

 
22. Enter the amount you wish to budget for that acount.  For this example, enter “100”. 

 
23. Click the Save button. 

 

NOTE:  This account will remain in your worksheet as long as you budget for it by placing a 
value in the cell. 

 
NOTE: If you decide you don’t need/want to budget for this account, you can clear the cell of all 
data and save the worksheet.  The account will no longer appear.  Or, if you enter a “0” into the 
cell the account will remain visable (as long as you did not suppress zeros in your user 
preferences) for the current fiscal year. 
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Comments and Supporting Details 
 
To elaborate on or explain the data entered into any cell, you may choose to add comments, or 
supporting details to the appropriate cell. 

 

Adding Comments 
 
Comments can be added to Level 0 or rollup accounts in both Budget Preparation forms and All 
Funds Budget forms. 

 

1. Right click on the cell to which you wish to add a comment. 
 

2. Choose Comments. 

 

3. Click Add, then type in the desired comment. 
 

 
 

 
 

4. Click the Add button in the bottom right of window, then Close to return to form. 
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You can tell a cell has a comment attached by noted the icon that appears in the upper, right 
corner of the cell. 

 

NOTE:  Comments cannot be edited, but you can add comments over comments if desired. 
Hyperion keeps track of the history for all comments. 

 

Deleting Comments 
 

1. Right-click the cell that has a comment. 
 

2. Click the Comment option.  

 

 

3. Select the comment you wish to delete (if there are more than one), click the Delete 
icon. 
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4. Click the Close button. 
 

5. Scroll down to confirm the cell no longer displays the icon in the upper, right corner. 

 

  

NOTE: Comments can be added to a level 0 member or parent member. 
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Supporting Details 
 
This function allows you to add calculations or aggregate lines to your budget cells. For example 
Travel and Training, you can add the airfare cost, lodge, meals etc. to the cell as supporting 
details. 

 

Supporting Details 
This function allows you to add calculations or aggregate lines to your budget cells.  

 

Supporting Details are "calculating" explanations you can add to specific cells if desired. 
 

 Supporting details allows you to add in specifics of a cell's entry.  For example, if travel 
expenses are expected to be higher than normal, you can use Supporting Details to 
explain everything that goes into that value. 

Supporting details can only be added to “0” level cells, not to the roll up level. If you get 
the following error message, you are on a roll up level. 

 

 

 

1. Right-click in cell to which you wish to add supporting details. 
 

2. Select the Supporting Detail option. 

 

 

The Supporting Detail window will pop up for you to enter the supporting detail. 
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You can add as many detail lines as needed.  In this example, we will add Airfare and Hotel 
costs. 

 

3. Type in the description of the first detail line in the Untitled field. 
 

4. Tab over and type in the amount of this detail line. 
 

 
 

5. To add an additional line on the same level, choose the Add Sibling button. 
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6. Type in a description for the second detail line. 
 

7. You will click the Add Child button if you need to include a calculated detail line.  In this 
example, we will input the calculations that contribute to the lodging costs. 

 

NOTE:  A child detail line will appear slightly indented from the previous parent line. 

 

8. Type in the description of the child line. 
NOTE:  In this example, we are calculating 10 days of lodging at $300 per night. 
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9. Click the Add Sibling button to add an additional detail line directly below Hotel Rate. 

 

10. Add the appropriate description for the new detail line. 
 

11. Double click the appropriate operator symbol for the calculation. 
NOTE:  In this example, we will be multiplying the Number of Days by the Hotel Rate to 
determine the expected In-State travel expenses for the Working Cut budget. 
 

12. Enter the appropriate number of expected travel days. 
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NOTE:  The Total field will automatically calculate. 

 

13. When all supporting details have been entered, click the Save button in upper, right 
corner of window, then click OK. 

 

 

14. Scroll down and notice that the cell(s) with the supporting detail will now be blue/green. 
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Editing/Deleting Supporting Details 
 

1. Right-click the cell that has the Supporting Details you want to edit or delete. 
 

2. Choose Supporting Detail. The supporting detail window will pop up for you to edit or 
delete. 

 

3. Edit the values as needed or click the appropriate Delete button (Delete or Delete All). 

  

NOTE:  Clicking Delete All will remove all Supporting Details from the cell. 

 

4. Click the Save button. 

 

After saving, you will determine whether you wish to remove the value and the supporting 
details from the cell on the main screen, or just delete the supporting details. 

 

 Choosing Yes  all data will be removed, including the cell value. 

 Choosing No  only the supporting details will be deleted. 
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In this case, we will remove the supporting details, but leave the value in the cell. 

 

5. Choose No, leave the value as it is, then click OK. 
 

6. Scroll down and confirm the supporting value has been removed from the cell(s). 

 

NOTE: Supporting Details can be added to a level 0 member or parent member. 

Smart View 

Opening Smart View 

 
Smart View allows you to access and work in the same Hyperion forms in a more familiar Excel 
environment. Smart View is a plugin that must be installed on your computer prior to use.  
Contact your tech support if you need Smart View installed.  Contact your tech support if you 
need Smart View installed or if you haven’t upgraded Smart View to 11.1.2.5. 

 

1. Open Excel and verify you can see a Smart View tab at the top of the application 
window. 
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Setting up Smart View Shared Connections URL 
Prior to using Smart View to complete all needed Budget Request Submission procedures, you 
will set up the appropriate Smart View connections. 
 

1. Open Excel and verify you can see a Smart View tab at the top of the application 
window. 

 

 

1. Click the Smart View tab, click the Options button and then select Advanced. 
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2. Type or paste the below URL in the Shared Connections URL field:  

 
https://prd4-budget.erp.ufl.edu/workspace/SmartViewProviders.  
 

3. Click OK. 

 
 

Smart View Option Settings 

https://prd4-budget.erp.ufl.edu/workspace/SmartViewProviders
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By default, missing data are displayed with #Missing. You can change the default display to 
other characters such as “-“. You can also make other formatting changes to Smart View. 
 

1. Click the Smart View tab, select Options, and select Data Options. 

 
  

Suppress rows that have no data. 

Suppress zeros. 

Suppress columns that have no data. 

 Display #Missing 
as other 
characters. 
Suggest to use “-” 
instead of “0”. 
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Connecting to Hyperion in Smart View 
You are now ready to connect to Hyperion using Smart View. 
 

1. Click the Smart View tab, click the Open button, and then click Smart View Panel. 
 

 
 

2. Select the Shared Connections option from the Smart View Home panel. 
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3. Type your GatorLink Username and Password. Click the Login button. 

 
 

4. Select “Oracle Hyperion Planning, Fusion Edition” from the Shared Connections 
Select Server drop down field. 
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You should see the Hyperion server at the top of the Shared Connections panel.  
 

5. Expand each level as follows: UBO_PSPB > Forms > Support Units. 
 

6. Confirm you can see the three Budget Request Submission forms: SU Budget 
Worksheet, SU Budget Worksheet-Level 0 Account and SU HCP Push Validation. Click 
on the form you need to work on. Select Open form on the bottom. 

 
7. Select your Entity, Cost Pool, Commitment Source and Budget Version from the 

Point of View (POV) bar at top of screen. 

 
8. You are encouraged to use the Smart View forms in the same order as you did in 

Hyperion.  Please refer to procedures SU HCP Push Validation, SU Budget Worksheet 
or SU Budget Worksheet-Level 0 Accounts as needed. 
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Input and Save Budget Data in Smart View 
As with Hyperion, you can enter or paste data into any open cell. 
 

1. Once you have entered data for all three budgets (Working Flat, Working Cut (if 
required) and Working Optimal), click Submit Data button to save and submit the data. 

 
NOTE: 
The unsaved data appears orange in Smart View. When data is submitted, the cell turns yellow.  
 
 

Copy, Paste and Cut 
The copy, paste and cut function are the same as those in Excel. 
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Populating Accounts 
The populating accounts procedure allows you to add accounts that were not previously used 
but will be needed and used in the future. 

 

1. From the Planning tab, right-click on the form. 
 

2. Right click on the form. Select Smart View > Populate SU Account 
 
 

  

 

 

In this example, we will use Account Code 772000. 
 

3. Enter the appropriate Account code in the Select Account(s) to add: field.  
 



 

Support Unit Budget Request 99 January 3, 2018 

 
 

4. Click the OK button. 
 

5. Note the “was successful” message that appears within the pop-up window.. 
 

6. Once this message appears, click the OK button.  
 

  
 

 
7. Confirm the account displays in the worksheet. 
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You can now begin budgeting for this account. 

 
NOTE: If you decide you don’t need/want to budget for this account, you can clear the cell of all 
data and save the worksheet.  The account will no longer appear.  Or, if you enter a “0” into the 
cell the account will remain visible (as long as you did not suppress zeros in your user 
preferences) for the current fiscal year. 
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Adding Comments 
 
You can add Comments to cells in Smart View. Adding Comments is a simple, non-

calculating way to elaborate on the content of a cell. 

 

25. To attach a Comment, simply right click the cell to which you want to attach the 

comment. 

26. Hover over the Smart View menu item and select Cell Comments. 

 

27. Click Add Comment button. 
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28. On the right side box, enter "This is a comment." 

 

 
 

Adding a Comment offers a history record feature that keeps track of changes 

made to the comment. You cannot edit a comment but when you add a new 

comment you will be able to see the prior versions. 

29. Click the Save button in the middle of the popup window. You should see your 

name, timestamp and the comments show up on the left side.  

 

 

30. Click Close. 

31. Note the cell is outlined in blue. 
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Adding Supporting Details 
 

You can add Supporting Details to cells in Smart View.   

 

Supporting Details are "calculating" explanations you can add to specific cells if desired. 

 

 Supporting details allows you to add in specifics of a cell's entry.  For example, if 

travel expenses are expected to be higher than normal, you can use Supporting 

Details to explain everything that goes into that value. 

 Supporting details can only be added to “0” level cells, not to the roll up level. If you 

get the following error message, you are on a roll up level. 

 

 

32. To add Supporting Details, first you must right-click the cell to which you want to 

add the supporting details. 

33. From the pop-up menu, hover over the Smart View option and click 

the Supporting Details menu. 
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34. Click on Add Child.  
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35. Enter "Rental Car" in the left side and enter “150.00” in the right side field. 

36. Click the Add Sibling option. 

 

 

37. Enter "Tolls" on the next line. 
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38. Enter "15.00" for the Tolls.  

Next you will enter hotel expenses.  The hotel will cost $185.00 for four nights. 

39. Click the Add Sibling button. 

40. Enter "Hotel" as the expense type. 

41. Click the Add Child button. 

42. Enter "Hilton" as the hotel. 

43. Enter the nightly amount in the next field.  For this example, enter "185.00". 

44. Click the Add Sibling button again. 

45. Enter the number of nights.  In this example, enter "4 nights". 

46. Double Click the + cell to select a different function.   

47. Click the * to multply. 

48. Enter "4" as the number of nights. Note that the Total is updated. 

 

 

49. To delete a row, click the Delete button. 
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50. To delete all rows, click the Delete All button. 

 

 

51. Click the "Submit" button. 

 The amount is entered into the field and it turns a different color, indicating it 

is saved. 
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Below screenshot shows the color coding for cells with comments, supporting details, and 
unsaved data.  Attaching documents using Smart View does not work if you need documents 
attached please do so within Hyperion. 

 

 

 

  

Cell with supporting 
details 

are highlighted in blue.

Cell with 
comments  
has blue outline. 

Cells with unsaved data are 
highlighted in orange. 
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Security 

The following myUFL security roles are created for the support unit users.  

 

UF_N_BP_COLLEGE_PLANNER 
This role will grant access to view and update budget information in UF’s budget software at the 
college level. 

 

UF_N_BP_COLLEGE_VIEWER 
This role will grant access to view budget information in UF’s budget software at the college 

level 

UF_N_BP_DEPT_PLANNER 
This role will grant access to view and update budget information in UF’s budget software at the 

department level 

UF_N_BP_DEPT_VIEWER 
This role will grant access to view budget information in UF’s budget software at the department 

level 

To have access to Hyperion application, the support unit users should request the 
UF_N_BP_COLLEGE_PLANNER role. 
 

The support unit users have read and write access to their responsible areas only. For example, 
the VP and Chief Information Officer user can only view and input budget for all IT departments, 
not other areas like Finance and Accounting. The SVP areas have read access to all the areas 
under their umbrella. For example, the SVP for Academic Affairs and the Provost Office can 
view the budget of DOCE, Graduate School, Library, International Center, Enrollment 
Management, CFO, Purchasing, Contracts and Grants, Finance and Accounting, and Student 
Affairs. However, the SVP for Academic Affairs and the Provost Office can only input and 
modify budget for the Provost’s Office, not the other areas just mentioned.  
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UBO_PSPB SU Application Overview 

Dimensions represent the key components of the application. The UBO_PSPB Support Unit 
Budget application contains the following dimensions: 
 

 Account 

 Entity 

 Commitment Source 

 Cost Pools 

 Fund 

 Program 

 Dept Flex 

 Scenario 

 Version 

 Year 

 Periods 
 

Account 
The Account dimension in UBO_PSPB is based on the account structure in PeopleSoft 
Financial system. Not all GL accounts in PeopleSoft Financial system are included in 
UBO_PSPB since the support units do not budget to every single GL accounts. To see 
the Account dimension hierarchy, go to SU Budget Worksheet. Expand and collapse the 
account to see the details. 

 

The account dimension will be revised each fiscal year. 
 

Entity 
The Entity dimension in UBO_PSPB is based on the Department structure in PeopleSoft 
Financial system. It is modified to reflect the budget reporting hierarchy.  

 

Commitment Source 
This is the support unit’s funding source.  Below is the dimension hierarchy: 
 
 Total Commitment Source 
  Support Unit Funding 
  Provost Funding  
  SVP HSC Funding 
  Concession Funding 
  Direct Bill Funding 
  No Commitment Source 
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Cost Pools 
Cost Pools dimension represent the cost pools your unit falls in. It is required to select a 
cost pool for your budget in UBO_PSPB. When you login to UBO_PSPB, you will only 
see the cost pools that your units belong to. Some units, for example, DSR or EH&S, 
Library, will see multiple cost pools. Please pay attenttion to which cost pool you are 
budgeting. 

 

Below is the cost pool dimension hierarchy: 

 Total Cost Pool 

  Info Technology 

  Bond Payment 

  Facilities 

  General Admin 

  HSC Admin 

   HSC Admin-Main 

   HSC Admin-IT 

  Sponsored Project Admin 

   SPA-Central 

   SPA-DSR Admin 

    SPA-DSR Central 

    SPA-DSR IRB-1 

    SPA-DSR IRB-2 

    SPA-DSR IRB-3 

    SPA-DSR IACUC 

    SPA-DSR Animal Care 

    SPA-DSR Biostatistics 

  Library 

   Library-Main 

   Library Administration 

   Library HSC 

  Student Services 

   Campus Student Admin 

   Grad ST Admin 
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Fund 
This dimension should be No Fund. 

 

Program 
This dimension should be No Program. 

 

Dept Flex 
This dimension should be No Dept Flex. 

 

Scenario 
This dimension shows the data is for SU_Actual or SU_Budget. 

 

Version 
This dimension shows whether you are working on or reviewing budget cut, optimal 
budget or flat budget or your final budget. 

 

Year 
This dimension shows the fiscal year. 

 

Periods 
This dimension shows the month of the fiscal year from July to June. 

 

 

 

 

 


